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About this Manual

Structure of this
Manual

This manual is divided up into the following chapters:

e Chapter 1 describes how to install Logiscope.

*  Chapter 2 describes specific settings for Logiscope on UNIX.

For mode details on license keys and installation, please refer to “IBM Rational Lifecycle Solutions -

Licensing Guide”.

Typographical Conventions

The following typographical conventions are used in this manual:

Typeface or Meaning
Symbol
Bold Book titles, important items, and items that you can select, including

buttons and menus. For example: Click Yes to continue.

Courier Commands, files, and directories; computer output. For example: Edit
your .properties file.

> A menu choice. For example: Select File > Open. This means select the
File menu, then select the Open command from it.

Contacting IBM
Rational Software
Support

If the self-help resources have not provided a resolution to your problem, you can contact IBM®
Rational® Software Support for assistance in resolving product issues.

Note If you are a heritage Telelogic customer, you can go to http://support.telelogic.com/toolbar
and download the IBM Rational Telelogic Software Support browser toolbar. This toolbar
helps simplify the transition to the IBM Rational Telelogic product online resources. Also,
a single reference site for all IBM Rational Telelogic support resources is located at:
http://www.ibm.com/software/rational/support/telelogic/.

Prerequisites

To submit your problem to IBM Rational Software Support, you must have an active
Passport Advantage® software maintenance agreement. Passport Advantage is the IBM
comprehensive software licensing and software maintenance (product upgrades and tech-
nical support) offering. You can enroll online in Passport Advantage from:

http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html


http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html
http://support.telelogic.com/toolbar
http://www.ibm.com/software/rational/support/telelogic/
http://www.ibm.com/software/rational/support/telelogic/
http://www.ibm.com/software/rational/support/telelogic/

IBM Rational Logiscope Installation Guide

* To learn more about Passport Advantage, visit the Passport Advantage FAQs at

http://www.ibm.com/software/lotus/passportadvantage/ brochures_faqs _quickguides.
html.

 For further assisance, contact your IBM representative

To submit your problem online (from the IBM Web site) to IBM Rational Software Sup-
port, you must additionally:

» Be aregistered user on the IBM Rational Software Support Web site. For details about
registering, go to http://www-01.ibm.com/software/support/.

* Be listed as an authorized caller in the service request tool

Submitting problems
To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a problem to IBM,
you are asked to supply a severity level. Therefore, you need to understand and assess
the business impact of the problem that you are reporting.

Use the following table to determine the severity level.

Severity Description

The problem has a critical business impact. You are unable to use the program,
1 resulting in a critical impact on operation. This condition requires an immediate
solution.

The problem has a significantl business impact. The program is usable, but it is

2 ..
severely limited.

3 The problem has a some business impact.The program is usable, but less significant
features (not critical to operation) are unavailable.

4 The problem has a minimal business impact.The problem causes little impact on

operations or a reasonnable circumvention to the problem was implemented.

2. Describe your problem and gather background information, When describing a
problem to IBM, be as specific as possible. Include all relevant background
information so that IBM Rational Software Support specialists can help you solve the
problem efficiently. To save time, know the answers to these questions:

» What software versions were you running when the problem occurred?
To determine the exact product name and version, use the option applicable to you:

« Start the IBM Installation Manager and select File > View Installed Packages.
Expand a package group and select a package to see the package name and
version number.

 Start your product, and click Help > About to see the offering name and

version number.

» What is your operating system and version number (including any service

packs or patches)?


http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html
http://www-01.ibm.com/software/support/
http://www-01.ibm.com/software/support/
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* Do you have logs, traces, and messages that are related to the problem
symptoms?

* Can you recreate the problem? If so, what steps do you perform to recreate
the problem?

* Did you make any changes to the system? For example, did you make
changes to the hardware, operating system, networking software, or other
system components?

* Are you currently using a workaround for the problem? If so, be prepared to
describe the workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit your
problem to IBM Rational Software Support in the following ways:

* Online: Go to the IBM Rational Software Support Web site at
https://www.ibm.com/software/rational/support/ and in the Rational support
task navigator, click Open Service Request. Select the electronic problem
reporting tool, and open a Problem Management Record (PMR), describing
the problem accurately in your own words.

For more information about opening a service request, go to
http://www.ibm.com/software/support/help.html

You can also open an online service request using the IBM Support
Assistant. For more information, go to http://www-01.ibm.com/
software/support/isa/fag.html.

* By phone: For the phone number to call in your country or region, go to
the IBM directory of worldwide contacts at http://www.ibm.com/planetwide/
and click the name of your country or geographic region.

* Through your IBM Representative: If you cannot access IBM Rational
Software Support online or by phone, contact your IBM Representative. If
necessary, your IBM Representative can open a service request for you. You
can find complete contact information for each country at
http://www.ibm.com/planetwide/.

If the problem you submit is for a software defect or for missing or inaccurate docu-
mentation, IBM Rational Software Support creates an Authorized Program Analysis
Report (APAR). The APAR describes the problem in detail. Whenever possible, IBM
Rational Software Support provides a workaround that you can implement until the
APAR is resolved and a fix is delivered. IBM publishes resolved APARs on the IBM
Rational Software Support Web site daily, so that other users who experience the same
problem can benefit from the same resolution.


https://www.ibm.com/software/rational/support/
https://www.ibm.com/software/rational/support/
http://www.ibm.com/software/support/help.html
http://www.ibm.com/software/support/help.html
http://www-01.ibm.com/software/support/isa/faq.html
http://www-01.ibm.com/software/support/isa/faq.html
http://www.ibm.com/planetwide/
http://www.ibm.com/planetwide/
http://www.ibm.com/planetwide/
http://www.ibm.com/planetwide/
http://www.ibm.com/planetwide/

IBM Rational Logiscope Installation Guide



Installing IBM Rational Logiscope

¢ Before You Install
* Installing IBM Rational Logiscope in Windows
e Installing IBM Rational Logiscope on UNIX

*  Start IBM Rational Logiscope

Before You Install

See also:

Administrator privileges required

For a successful installation of IBM Rational Logiscope, you must have access to a computer account
IBM Rationalwith system administrator privileges.

About license keys and installation

IBM Rational Logiscope uses FLEXnet for licensing. This means that you will need a FLEXnet
license key to be able to use IBM Rational Logiscope. Depending on your type of license agreement,
the license information may already have been delivered to you by e-mail. If you are a new user and
this is your first license agreement, that is probably not the case.

During installation, it is assumed that you have the license information at hand, at least hostname and
port number. You may add the license information later and do not need to install again.

For more details, please refer to “IBM Rational Lifecycle Solutions - Licensing Guide”

Installing IBM
Rational
Logiscope in
Windows

In the following, it is assumed that the CD-ROM dtive is mounted on D: \ (or that D: \ is the place
where you have downloaded the software from the support web).

Install IBM Rational Logiscope in Windows
1. Log on as administrator or make sure that you have administrative privileges.
2. Exit all running Windows programs.

3. A welcome screen will automatically be opened when inserting the CD, where you can select to
start the installation.

Note: If this is not started automatically, double-click D:\IBM Rational Logiscope 6.6.msi. If you
have downloaded the software from the support web, start by unzipping the download file
then double-click D:\IBM Rational Logiscope 6.6.msi.
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Installing IBM
Rational
Logiscope on
UNIX

Install IBM Rational Logiscope on UNIX
1. Logon to the UNIX host on which you want to install IBM Rational Logiscope.

2. Mount the CD-ROM (Volume 4) or download and unzip the software from the support web.
3. Execute the installation script from the directory Logiscope/unix on the CD-ROM:
$ ./tauinst.cd

The installation script will start and guide you through the rest of the setup.

License environment on UNIX

During installation, you will be asked for the license server and port number used. You find this
information on the first line of the FLEXnet license file. The entered information is verified and if a
valid license is found a file license.dat is created in the installation directory. This file defines the
license environment for Logiscope such that any user can start Logiscope directly without setting any
license environment vatiables.

If the servername and/or port number is not available or the license cannot be verified a file
license.txt will be created in the installation directory. Once you have the correct information replace
servername and port number in this file with the real values and rename the file to license.dat.

Set up printers and windows appearance on UNIX (optional)

Before you start using Logiscope on UNIX, you may want to set up PostScript printers. It is also
possible to set up the appearance of the windows used by Logiscope (this can also be done later on).
Printers and window appearances are set up by using the Control Panel that is supplied with
Logiscope. Refer to “Control Panel” on page 7.

Start IBM
Rational
Logiscope

Start IBM Rational Logiscope in Windows

Start IBM Rational Logiscope from the Start menu. In the Programs submenu, select IBM
Rational and then IBM Rational Logiscope 6.6.

Start IBM Rational Logiscope on UNIX

After the environment is set up, start IBM Rational Logiscope by typing the full path name:

<installation path>/bin/vcs



Setting up Logiscope on UNIX

This chapter contains information about how to set up your UNIX environment for Logiscope.
*  Logiscope and MainWin
*  Control Panel

*  Floating toolbars

Logiscope and
MainWin

Registry

Logiscope on UNIX platforms uses a third-party software, MainWin, that provides access to the
Win32 API on UNIX environments. Hence, through MainWin, Logiscope is given a nearly identical
behavior and look-and-feel on UNIX as on Windows, the exceptions being described in “Control
Panel” on page 7 and “Floating toolbars” on page 11.

The subset of the Windows Registry that is required for applications that use MainWin to run (such
as Logiscope) is, although available to the end user through the regedit application, not intended
to be modified.

Note: Do not, unless specifically instructed to do so, modify or remove any Registry keys.
Otherwise it may result into a corrupt installation of Logiscope.

Control Panel

The Control Panel (implemented by MainWin) is available with Logiscope for the users’
convenience. It contains a collection of utilities that allow to set up properties in a similar fashion as
would have been done in a Windows environment.

BY MainWin Control Panel Mi=] E3
Eile  Miew Help

REEEE|?

£ g & @

. . DateiTime Printers Regianal
kainWin Se?tings
Control Panel .

&
Internet Display
Qptiong

Figure 1: The Control Panel
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Starting the control panel

The Control Panel is started with the command: mwcontrol (mwcontrol islocated in the
bin directory of your Logiscope installation).

This command opens a window holding icons that have an appearance and functionality similar to
their equivalence in the Windows Control Panel.

Only the Printers and Display settings are meaningful to use in the context of Logiscope.

Setting the appearance of Logiscope windows

The Display applet implements a subset of the Windows Display Properties. Use the Display applet
should you want to configure the appearance of the windows used by Logiscope applications (such
windows font size and family, colors and sizes of menu bars, scrollbars and buttons etc.)

Display Properties

Appearance |

Inactive Window =]
Active Window _ O]

mormal  Disahled
Window Text

Message Box
Message Test

N | s s | Delste |

Item: EHEET Calar;

IDesktcup j I :I -|'|

Font: = (][]

| = B
Ok | Cancel | e | |

Figure 2: Setting the appearance of Logiscope
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PostScript printer
description files

When you make changes using the Display applet, the changes only affect Logiscope sessions that
you start after you have saved the Display changes. Logiscope sessions that were running when you
changed the Display must be restarted for your changes to take effect.

Note: The Display Properties does not affect your UNIX desktop. Neither does it impact the
color, spacing and font properties used for diagrams managed by Logiscope — to change
such properties, use the Options command from the Tools menu in Logiscope.

Setting up printers

The Printers applet is similar to the Windows Printers applet. However, unlike Windows, when
setting up a printer you do not map an actual printer for use with Logiscope. Instead, you map a print
request to a proper print command on your UNIX host. Thus, the procedure for adding new print
capabilities differs slightly from that on Windows.

B3 MainWin Printers
File Miew Tools Help

EERER ?

=100 ]

S Mew Genetic Generic
Printer PostScri..  Postscript

Main¥in

Printers

Figure 3: Setting up printers

Note: Changes made using the Printers applet affect Logiscope sessions running on the same
machine as soon as you save the changes. Instances of Logiscope running on other
machines must be restarted for the changes to take effect.

PostScript Printer Description (PPD) files describe how to use features that are special for a specific
PostScript printer. So, to take advantage of your printer's specific features — for example, duplex
printing or paper tray selection — you need a PPD file. Most printer vendors provide PPD files for
their printers. For your convenience, a large subset of the PPD files that are included with Windows
is supplied with Logiscope. In addition, a PPD file for generic PostScript printers, which should
allow you to print on any PostScript printer, is also provided.

The Printers applet also includes an “Add New Printer” wizard, described below.

Note: If you already have a printer installed with an application that uses a previous version of
Mainwin, then you do not need to add the same printer again. The Printers applet now
includes an option, from the Tools menu, to import existing printers. The imported
printers will be associated with a default PPD file, and may not access all the printet's
features.



Add New Printer

1.
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Start by launching the Control Panel (by typing the mwcontrol command) and double-click
Printers.

Double-click Add New Printer to start the Add New Printer wizard.

* Atany time, the Add New Printer can be browsed back and forward using the Next and
Back buttons.

Click Next to specify the UNIX printer of your choice.

*  Alist of the printers defined on the UNIX host appears at the bottom of the dialog, along
with their descriptions. The list of printers is extracted from the /etc/printcap file,
which contains a list of all printers on the network to which your UNIX host has access. The
printcap fileis used on all UNIX platforms as the central location for specifying printers.
It is configured and maintained by the system administrator.

* If the printer you want to add is on the list, simply select it.

* To add a printer that does not appear on the list, type the UNIX name of the printer in the
UNIX printer text input field.

Click Next in order to specify the default Print Command for the selected printer.

*  Usually, the default command is the one you should use. You should ask your system
administrator before changing this command.

*  If you manually added a UNIX name of a printer in the previous step, the print command
will automatically use that name.

Click Next to specify the manufacturer and model of your printer, and the appropriate PPD file
to use.

* If you have your own PPD file, then click Choose File to locate your PPD file. After
specifying the name and location of the file (using full path name), click OK.

*  You must either have write permission to the ditectory SMWHOME / system/ppd, ot you
must set the MWVPPD_DIR environment variable to a directory to which you have write
permission.

* Ifyoudo not select anything in the Choose PPD File page, then a default generic PPD file is
automatically selected.

Click Next, which allows you to specify a printer name and description of your own.

*  The Add New Printer wizard provides a default printer name, which you may modify in the
Printer Name text box.

*  The Printer Description text box has the same functionality as on Microsoft Windows. This
field may be left blank.

Click Next and decide whether you want this printer to be your default printer.

*  This Default Printer page will not appear in the wizard if this is the first printer you are
setting up. First when adding another printer, then you will be provided the option to
choose your default printer.

Click Next. Now the wizard asks you if you want to print a test page — like in Windows — that
supplies you with various information, such as the features of the added printer.

Click Next and verify that the information you specified in the Add New Printer wizard is
correct.

e Ifyou are satisfied with the settings, click Finish.
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*  Otherwise, click Back to change the settings.
The printer you added now appears in the Printers applet, among the previously added printers.

Floating toolbars

When running Logiscope applications that have floating toolbars, such toolbars behave differently

on UNIX from their behavior on Windows.

Behavior on Windows

Behavior on UNIX

Double-clicking the title bar of a floating
toolbar window returns the toolbar to its
otiginal position on the application's window,
below the menu bar.

Double-clicking the title bar of a floating
toolbar window does not do anything. To
return the toolbar to its location on the
application window, click the window system
menu at the top left corner of the toolbar
window and select Redock.

When dragging a floating toolbar window over
the toolbar area of the application window, a
rectangle appears to indicate what the size and
location of the toolbar would be should it be
dropped in that position.

When dragging a floating toolbar window over
the toolbar area of the application window, no
rectangle appears to indicate the size and
location of the toolbar in its place on the
application window. Instead, the floating
toolbar is dragged. When dropped, the toolbar
is correctly placed inside the application's
window.
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Notices

© Copyright 1985, 2009

U.S. Government Users Restricted Rights - Use, duplication, or disclosure restricted
by GSA ADP Schedule Contract with IBM corp.

This information was developed for products and services offered in the US.A. IBM
may not offer the products, services, or features discussed in this document in other
countries. Consult your local IBM representative for information on the products
and services currently available in your area. Any reference to an IBM product,
program, or service is not intended to state or imply that only that IBM product,
program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used
instead. However, it is the uset's responsibility to evaluate and verify the operation of
any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you any
license to these patents. You can send written license inquiries to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send written
inquiries to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND,
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain
transactions. Therefore, this statement may not apply to you.
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This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites ate provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs
and other programs (including this one) and (i) the mutual use of the information
which has been exchanged, should contact:

Intellectual Property Dept. for Rational Software
IBM Corporation

1 Rogers Street

Cambridge, Massachusetts 02142

US.A.

Such information may be available, subject to apptropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available
for it are provided by IBM under terms of the IBM Customer Agreement, IBM
International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
petformance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similatity to the names and addresses used by an actual business
enterprise is entirely coincidental.
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If you are viewing this information softcopy, the photographs and color illustrations
may not appeat.

Trademarks

IBM, the IBM logo, ibm.com ate tradematks or registered trademarks of
International Business Machine Corp., registered in many jurisdictions worldwide.
Other product and services names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at:

www.ibm.com/legal/copytrade.html.

Adobe, the Adobe logo, Acrobat, the Acrobat logo, FrameMaker, and PostScript are
trademarks of Adobe Systems Incorporated or its subsidiaries and may be registered
in certain jurisdictions.

AIX and Informix are trademarks or registered trademarks of International Business
Machines Corporation in the United States, other countries, or both.

HP and HP-UX are registered trademarks of Hewlett-Packard Corporation.

Java and all Java-based trademarks and logos ate tradematks of Sun Microsystems,
Inc. in the United States, other counttries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countties, or both.

Macrovision and FLEXnet are registered trademarks or trademarks of Macrovision
Corporation.

Microsoft, Windows, Windows 2003, Windows XP, Windows Vista and/or other
Microsoft products referenced herein are either trademarks or registered trademarks
of Microsoft Corporation.

Netscape and Netscape Enterprise Server are registered trademarks of Netscape
Communications Corporation in the United States and other countries.

Sun, Sun Microsystems, Solaris, and Java are trademarks or registered trademarks of
Sun Microsystems, Inc. in the United States and other countries.

Pentium is a trademark of Intel Corporation.

ITIL is a registered tradematk, and a registered community trademark of the Office
of Government Commerce, and is registered in the US Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product or service names may be tradematks or setvice marks of
others.
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